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<BlocksExchange version="2.1">

<!-- Definition of one or several useful spatial reference systems (SRS).-->
<!-- Here, we need the French Lambert 93. -->
<SpatialReferenceSystems>
<SRS>
<l-- In the sequel, the SRS is referred to by this ID.-->
<Id>0</Id>
<!-- User-friendly SRS name.-->
<Name>Lambert 93</Name>
<!-- The spatial reference system definition can be either a Well

Known Text
definition (e.g. WGS84), "EPSG:", a PROJ.4 definition, or the path to a file
containing such a definition.-->

<Definition>EPSG:2154</Definition>

</SRS>
</SpatialReferenceSystems>
<!-- Optional:a path to prefix image paths when they are not absolute

(default:use the directory of the exchange file).-->
<BaseImagePath>D:\data\Paris2012sample\Images</BaseImagePath>

<!-- Block definition.A single file can define several blocks.-->
<Block>
<!-- Block name and description are optional.-->

<Name>Paris2012</Name>
<Description>Small sample of the Paris 2012 dataset</Description>
<!-- The type of block is optional.Supported types are:Aerial, Nadir and

Orbit.-->

<Type>Aerial</Type>

<!-- Photo downsampling rate can be optionally provided with
<PhotoDownsamplingRate> tag -->

<!-- Minmum and maximum viewing distance can be optionally provided with

<MinimumViewingDistance> and <MaximumViewingDistance> tags -->
<!-- ID of the base SRS used in the block.By default, the spatial

reference
system is assumed to be a local Cartesian coordinate system.-->
<SRSId>0</SRSId>
<Photogroups>
<!-- All photos taken using the same physical camera, with

identical focal
length and dimensions must be gathered in a photogroup.-->
<Photogroup>
<!-- Optionally, a different spatial reference system can be
specified for
each photogroup with the <SRSId> tag.By default, the SRS of the block is assumed.
-->
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<l-- Optionally, a name with the <Name> tag, and a
description with a
<Description> tag.-->
<Name>UCX</Name>
<!-- Image dimensions, in pixels.-->
<ImageDimensions>
<Width>9420</Width>
<Height>14430</Height>
</ImageDimensions>
<!-- Optional camera model type Perspective or Fisheye

(Perspective
type is used if this tag is unspecified).-->
<CameraModelType>Perspective</CameraModelType>
<!-- Optional camera model band Visible or Thermal (Visible type is
used if this tag is unspecified).-->
<CameraModelBand>Visible</CameraModelBand>

<!-- Sensor's largest dimension, in millimeters.-->

<!-- Sensor's pixel size, in millimeters, can be substituted
for this field.

-->

<!-- For this dataset, it would be:-->

<!l-- <PixelSize>0.0072</PixelSize> -->

<SensorSize>103.896</SensorSize>

<!-- Focal length, in millimeters.This can be either the
nominal

specification or a closer estimate.-->
<Focallength>100.735601903992</FocallLength>
<!-- Optionally, focal length, in pixels.Can replace
FocallLength and
SensorSize data.-->

<!-- For this dataset, it would be:-->
<!l-- <FocallLengthPixels>13991.05582</FocallLengthPixels> -->
<!-- Optionally, specification of the xy-axis of the camera

sensor for
pose rotation and for any position given in millimeter (i.e. <PrincipalPoint> and
<Measurement> when using <xmm> and <ymm>) -->
<!-- Possible values:XRightYDown (default), XRightYUp (more
frequent
in photogrammetry), XLeftYDown, XLeftYUp, XDownYRight, XDownYLeft, XUpYRight,
XUpYLeft -->
<CameraOrientation>XRightYDown</CameraOrientation>
<!-- Principal point, with respect to the sensor center.This
field is
optional:by default, the sensor center is used as an initial estimate of the
principal point.-->
<PrincipalPoint>
<!-- 2D image position of the principal point, in
pixels.The origin
is the center of the upper-left image pixel, the x-axis is oriented to the
right side of the image, and the y-axis is oriented to the bottom of the image.-->
<x>4683.755692</x>
<y>7223.0141002</y>
<l-- Alternatively, a 2D position with respect to the
sensor
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center can be specified, in millimeters.In this case, the xy-axis are oriented
according to CameraOrientation.-->

<!-- For this dataset, it would be:-->

<l-- <xmm>-0.1853590176</xmm> -->

<l-- <ymm>0.06130152144</ymm> -->

</PrincipalPoint>
<!-- Lens distortion coefficients.This field is

optional:by default,
no distortion is assumed as an initial estimate.-->

<!-- Distortion coefficients correspond to the classical
Brown's
distortion model, as described in http://en.wikipedia.org/wiki/Distortion_(optics)
-
<Distortion>

<K1>-0.0010041516639</K1>
<K2>0.0056007056563</K2>
<K3>-0.009874171117100001</K3>

<P1>0</P1>
<P2>0</P2>
</Distortion>
<!-- Fisheye focal matrix used only for the camera model

type Fisheye.-->
<FisheyeFocalMatrix>
<M_00>1960</M_00>
<M_01>0</M_01>
<M_10>0</M_10>
<M_11>1960</M 11>
</FisheyeFocalMatrix>
<!-- Fisheye distortion coefficients used only for the
camera model type
Fisheye.-->
<FisheyeDistortion>
<PO>0</K1>
<P1>1</K2>
<P2>0</K3>
<P3>0</P1>
<P4>0</P2>
</FisheyeDistortion>
<Photo>
<!-- The ID of a photograph must be unique over the
whole block (in other
words, even across other photogroups).-->
<Id>146</Id>
<!-- Path of the image.If not absolute, it is
considered to be relative to
BaseImagePath if defined, or otherwise to the directory of the exchange file.-->
<ImagePath>071_2810. jpg</ImagePath>
<!-- Optional path of the image mask.If not absolute,
it is
considered to be relative to BaseImagePath if defined, or otherwise to the
directory of the exchange file.-->
<l-- <MaskPath>071_ 2810 _msk.jpg</MaskPath> -->
<!-- Exterior orientation of the camera, as estimated
by navigation
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devices or aerotriangulation.This field is optional.-->
<!l-- Optional component Id:1 is the main component
(default), @ is no
component.Photos with incomplete pose cannot belong to the main component -->

<!-- <Component>1</Component> -->
<Pose>
<!-- 3D rotation of the camera in the spatial
reference system
defined above.-->
<l-- It defines the rotation matrix

transforming world coordinates
(in the specified SRS) into camera coordinates (with axes defined by the
CameraOrientation of the photogroup).-->
<!-- The rotation is optional:the pose can be
limited to the 3D position
of the camera center (e.g. when GPS position only is available).-->

<Rotation>
<l-- It can be specified in one of the
four representations below:-->
<!-- 1. A 3x3 matrix, using the <M_ij>

tags, where M_ij denotes the

coefficient of the (i+l1)th row and the (j+1)th column of the rotation matrix.-->
<M_00>-0.9999982912233401</M_00>
<M_01>-0.001636319085375301</M_01>
<M_02>-0.0008602425863163225</M_02>
<M_10>-0.001631068695467463</M_10>
<M_11>0.9999802528616577</M_11>
<M_12>-0.00606906089589293</M_12>
<M_20>0.0008701565192966738</M_20>
<M_21>-0.006067647409696231</M 21>
<M_22>-0.9999812130648239</M_22>
<l-- 2. Omega/Phi/Kappa angles, in

degrees, using the <Omega>, <Phi>,

<Kappa> tags.Please refer to the formula in the camera model document.-->
<!-- For this dataset, it would be:-->
<l-- <Omega>179.6523471469934</0mega> -->
<!-- <Phi>0.04985630236313049</Phi> -->
<!-- <Kappa>179.9065465708369</Kappa> -->
<l-- 3. Heading/Pitch/Roll angles, in

degrees using the <Heading>,

<Pitch>, <Roll> tags.Please refer to the formula in the camera model document.-->

<!-- 4. Yaw/Pitch/Roll angles, in degrees using the <Yaw>, ,Pitch>,
<Roll> tags.Please refer to the formula in the camera model document.-->

</Rotation>

<!-- 3D position of the camera center in the
spatial reference system
defined above.-->

<!-- Depending on the SRS, x/y may stand either
for longitude/latitude,
for map projection coordinates, or for something else.-->

<!-- Depending on the SRS, z may stand either
for a geoid height, for
an orthometric height, or for something else.-->
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<Center>
<x>651999.7159189156< /x>
<y>6863073.633923346</y>
<z>1318.897690166719</z>
</Center>
</Pose>
<!-- Optional depth information can be provided with
<NearDepth>,
<MedianDepth>, and <FarDepth> tags -->
<!-- Optional Exif data (each exif data property is
optional)
--><)--
<ExifData>
<ImageDimensions>
<Width>4000</Width>
<Height>3000</Height>
</ImageDimensions>
<PixelDimensions>
<Width>0.02</Width>
<Height>0.02</Height>
</PixelDimensions>
<GPS>
<Latitude>45.5686684</Latitude>
<Longitude>2.6551104</Longitude>
<Altitude>1589.5469</Altitude>
</GPS>
<FocallLength>24</FocallLength>
<FocallLength35mmEq>36</FocallLength35mmEqg>
<Make>FUJIFILM</Make>
<Model>FinePix S3Pro</Model>
<LensModel>FinePix S3Pro</LensModel>
<DateTimeOriginal>2015-04-
29T06:40:26</DateTimeOriginal>
</ExifData> -->

</Photo>
</Photogroup>
</Photogroups>
<l-- Control points are highly recommended for accurate positioning.-->
<ControlPoints>
<!-- Optionally, a different spatial reference system can be
specified
with the <SRSId> tag.By default, the SRS of the block is assumed.-->
<ControlPoint>
<!-- Control point name and description are optional.-->
<Name>Control point #1</Name>
<!-- Optionally, a different spatial reference system can be
specified

for each control point with the <SRSId> tag.By default, the SRS of the control
points container is assumed.-->
<!-- 3D position of the control point in the active spatial
reference
system.-->
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<!-- Depending on the SRS, x/y may stand either for
longitude/latitude,
for map projection coordinates, or for something else.-->

<!-- Depending on the SRS, z may stand either for a geoid
height, for an
orthometric height, or for something else.-->
<Position>
<X>652788.0525588237< /x>
<y>6863015.362218254</y>
<z>78.07000000122935</z>

</Position>
<!-- Image measurements.-->
<Measurement>
<!-- ID of the photo where the measurement is

taken.The measurements of
a control point must have different photo IDs.-->

<PhotoId>151</PhotoId>

<!-- 2D image position of the measurement, in
pixels.The origin is the
center of the upper-left image pixel, the x-axis is oriented to the right side of
the image, and the y-axis is oriented to the bottom of the image.-->

<!-- Alternatively, a 2D position with respect to the
principal point, in
millimeters.In this case, the xy-axis are oriented according to the
CameraOrientation of the corresponding photogroup.-->

<!-- For this dataset, it would be:-->

<l-- <xmm>18.6231910176</xmm> -->

<!-- <ymm>-4.48973352144</ymm> -->

<X>7270.31</x>

<y>6599.44</y>

</Measurement>

</ControlPoint>
<ControlPoint>
<Name>Control point #2</Name>
<Position>
<x>652123.2211166573</x>
<y>6863245.976366176</y>
<2>80.07999999914318</z>
</Position>
<!-- If specified, a control point may be a check point
(default:false)-->
<CheckPoint>true</CheckPoint>
<l-- If specified, a control point may have accuracies -->
<HorizontalAccuracy»>0.01</HorizontalAccuracy>
<VerticalAccuracy>@.10</VerticalAccuracy>
<Measurement>
<PhotoId>146</PhotoId>
<X>3296.56</x>
<y>9253.75</y>
</Measurement>

</ControlPoint>
<ControlPoint>
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<Name>Control point #3</Name>
<!-- If specified, a control point might be Full (default),
Horizontal or
Vertical -->
<Category>Horizontal</Category>
<Position> <!-- no z position -->
<Xx>652365.1205012415< /x>
<y>6863549.148163618</y>
</Position>
<HorizontalAccuracy>0.01</HorizontalAccuracy> <!-- no
vertical accuracy -->
<Measurement>
<PhotoId>95</PhotoId>
<X>3178.26</x>
<y>4020.21</y>

</Measurement>
</ControlPoint>
</ControlPoints>
<!-- Known tie points may be used to refine an aerotriangulation.-->
<!'-- Uncomment this section before import to get a single tie point in

the
imported block.Please note that a reconstruction created from a such block will
fail.-->

<!--<TiePoints>

--><!-- Optionally, a different spatial reference system can be
specified
with the <SRSId> tag.By default, the SRS of the block is assumed.--><!--
<TiePoint>
--><!-- Tie point name and description are optional.--><!--
--><!-- Optionally, a different spatial reference system can

be specified
for each tie point with the <SRSId> tag.By default, the SRS of the tie points
container is assumed.--><!--
--><!-- Optional 3D position of the tie point in the active
spatial reference
system.--><!--
--><!-- Depending on the SRS, x/y may stand either for
longitude/latitude,
for map projection coordinates, or for something else.--><!--
--><!-- Depending on the SRS, z may stand either for a geoid
height, for an
orthometric height, or for something else.--><!--
<Position>
<x>652119.8871409688< /x>
<y>6863304.305716386</y>
<z>87.79328384995461</z>
</Position>
--><!-- Optional tie point color.--><!--
<Color>
<Red>0.59</Red>
<Green>1.0</Green>
<Blue>0.0</Blue>
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</Color>
--><!-- Image measurements.--><!--
<Measurement>
--><!-- Optional measurement type User or Automatic

(Automatic type is
used if this tag is unspecified).--><!--
<Type>Automatic</Type>
--><!-- ID of the photo where the measurement is
taken.The measurements
of a tie point must have different photo IDs.--><!--
<PhotoId>146</PhotoId>
--><!-- 2D image position of the measurement, in
pixels.The origin is
the center of the upper-left image pixel, the x-axis is oriented to the right
side of the image, and the y-axis is oriented to the bottom of the image.--><!--
--><!-- Alternatively, a 2D position with respect to
the principal point,
in millimeters.In this case, the xy-axis are oriented according to the
CameraOrientation of the corresponding photogroup.--><!--
<X>3324.26001</x>
<y>9930.269531</y>
</Measurement>
<Measurement>
<PhotoId>158</PhotoId>
<X>9079.006836000001< /x>
<y>9902.772461000001</y>
</Measurement>
<Measurement>
<PhotoId>162</PhotoId>
<X>6240.366211< /x>
<y>9896.118164</y>
</Measurement>
</TiePoint>
</TiePoints>-->
<!-- Optional block's positioning constraints based on user tie point (@
based indices).-->
<!-- Each constraint is optional.-->
<!--<PositioningConstraints>
<OriginConstraint>
<0>2</0>
</OriginConstraint>
<ScaleConstraint>
<A>0</A>
<B>3</B>
<DistanceAB>56.350</DistanceAB>
</ScaleConstraint>
<AxisConstraint>
<A>0</A>
<B>3</B>
<AxisAB>z</AxisAB> --><!-- x, y, or z --><!--
</AxisConstraint>
<OrientationConstraint>
<A>0</A>
<B>3</B>
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<C>2</C>
<AxisAB>z</AxisAB> --><l-- x, y or z --><!--
<AxisSideC>upperX</AxisSideC> --><!-- lowerX, upperX,

lowerY, uppery,
lowerz, or upperZ --><!--
</OrientationConstraint>
</PositioningConstraints>--><PointClouds>
<PointClouds>
<PointCloud>
<Name>PointCloud name</Name>
<Description>Description of the
pointcloud</Description>

<Path>Absolute or relative path to the POD pointcloud

file</Path>

<CreatedDateTime>2017-05-26T15:59:08</CreatedDateTime>

<SRS>SRS definition</SRS> (can be empty)

<BoundingBox>
<XMin></XMin>
<XMax></XMax>
<YMin></YMin>
<YMax></YMax>
<ZMin></ZMin>
<ZMax></ZMax>
</BoundingBox>
<MinResolution>0.0232077879728498</MinResolution>
<MedResolution>0.0480807854162596</MedResolution>
<MeanResolution>0.0779783209951879</MeanResolution>
<MaxResolution>4.71837838822922</MaxResolution>
<ColorMode></ColorMode><!-- UseIntensity or UseColor or None -->
<Scans>
<Scan>
<Name>Scan name</Name>
<NumPoints>320519</NumPoint>
<Attributes>2</Attributes>
<l-- If static scan -->
<SourcePosition>
<X>0.05</x>
<y>18.59</y>
<z>58.369</z>

</SourcePosition>
<!-- If mobile scan -->
<Trajectories>
<Trajectory>
<Point>
<X>0.05</x>
<y>18.59</y>
<z>58.369¢</z>
</Point>
</Trajectory>
<Trajectories>
</Scan>
</Scans
</PointCloud>
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</PointClouds>

</Block>

</BlocksExchange>
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2D ATV Ok - FR(HBUTI)
<?xml version="1.0" encoding="utf-8"?>
<ContextScene version="2.0">
<PhotoCollection>
<Photos> <!-- List of images part of the ContextScene -->
<Photo id="0"> <!-- Image unique ID -->

<ImagePath>Q:/Analyze/OrbitJobs/Samples/Datasets/Motos/IMG_1059.JPG</Im
agePath> <!-- Image path -->
</Photo>
<Photo id="1">

<ImagePath>Q:/Analyze/OrbitJobs/Samples/Datasets/Motos/IMG_1060.JPG</Im
agePath>
</Photo>
<Photo id="2">

<ImagePath>Q:/Analyze/OrbitJobs/Samples/Datasets/Motos/IMG_1061.JPG</Im
agePath>
</Photo>
</Photos>
</PhotoCollection>
<Annotations> <!-- Annotations part of the ContextScene -->
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<Labels> <!-- List of classes composing the annotations -->
<Label id="3"> <!-- unique ID of one class -->
<Name>car</Name> <!-- Class name defined by detector -->
</Label>
<Label id="4">
<Name>motorcycle</Name>

</Label>

<Label id="85">
<Name>clock</Name>

</Label>

<Label id="15">
<Name>bench</Name>
</Label>
</Labels>
<Objects2D> <!-- List of 2D Objects part of the ContextScene -->
<ObjectsInPhoto>
<Photold>0</Photold> <!-- Photo ID displaying 2D-objects and
referring to Photo ID defined above -->
<Objects>
<Object2D id="0"> <!-- Single Object ID -->
<Labellnfo>
<Confidence>0.998535</Confidence>
<!-- Detection score rating confidence the target is actually part of the right class -->
<Labelld>3</Labelld> <!-- Label ID as
defined above -->
</Labellnfo>
<Box2D> <!-- 2D object's coordinates in % of
image size -->
<xmin>0.031909991055727</xmin>
<ymin>0.537032842636108</ymin>
<xmax>0.37431874871254</xmax>
<ymax>0.66499537229538</ymax>
</Box2D>
</Object2D>
</Objects>
</ObjectsInPhoto>
</Objects2D>
</Annotations>
</ContextScene>

3D ATk - FER(HBTI)
<?xml version="1.0" encoding="utf-8"?>
<ContextScene version="2.0">
<SpatialReferenceSystems> <!-- Spatial Reference System — Optionnal -->
<SRS id="0"> <!-- Spatial Reference System ID -->
<Definition>ENU:36.71339,-6.10019</Definition> <!-- Spatial Reference
System Definition -->
</SRS>
</SpatialReferenceSystems>
<Annotations>
<SRSId>0</SRSId>
<Labels> <!-- List of classes composing the annotations -->
<Label id="84"> <!-- unique ID of one class -->
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<Name>connection box</Name> <!-- Class name defined by
detector -->
</Label></Label>
</Labels>
<Objects3D> <!-- List of 3D Objects part of ContextScene-->
<Object3D id="0"> <!-- Single 3D Object ID-->
<Labellnfo>
<Labelld>84</Labelld> <!-- Label ID as defined above -->
</Labellnfo>
<RotatedBox3D>
<Box3D> <!-- 3D coordinates of 3D Object in defined SRS

<xmin>-4.32935880992287</xmin>
<ymin>-15.5213085471863</ymin>
<zmin>36.6455288658342</zmin>
<xmax>-3.92620580047086</xmax>
<ymax>-15.178094920882</ymax>
<zmax>36.7824782388701</zmax>
</Box3D>
<Rotation> <!-- Orientation of 3D Object following
rotation matrix---->
<M_00>0.0130315651698905</M_00>
<M_01>0.99991508554938</M_01>
<M_02>0</M_02>
<M_10>-0.99991508554938</M_10>
<M_11>0.0130315651698905</M_11>
<M_12>0</M_12>
<M_20>0</M_20>
<M_21>0</M_21>
<M_22>1</M_22>
</Rotation>
</RotatedBox3D>
</Object3D>
</Objects3D>
</Annotations>
</ContextScene>

2D BT A T—ay - FRHUTN)
<?xml version="1.0" encoding="utf-8"?>
<ContextScene version="2.0">
<PhotoCollection> <!-- collection of photos composing the ContextScene -->
<Photos>
<Photo id="0">

<ImagePath>Q:/Analyze/OrbitJobs/Samples/Datasets/Motos/IMG_1059.JPG</Im
agePath> <!-- Image path -->
</Photo>
<Photo id="1">

<ImagePath>Q:/Analyze/OrbitJobs/Samples/Datasets/Motos/IMG_1060.JPG</Im
agePath>
</Photo>
</Photos>
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</PhotoCollection>
<Annotations>
<Labels> <!-- List of classes composing the annotations -->
<Label id="0"> <!-- unique ID of one class -->
<Name>background</Name> <!-- Class name defined by detector

</Label>
<Label id="1">
<Name>aeroplane</Name>
</Label>
<Label id="2">
<Name>bicycle</Name>
</Label>
</Labels>
<Segmentation2D> <!-- List of segmented images (masks) applied to original
images after detection -->
<PhotoSegmentation>
<Photold>0</Photold> <!-- Refers to Photo ID defined above and
describing input images -->
<Path>Segmentation2D/0.png</Path> <!-- Segmented
orthophoto mask's name -->
</PhotoSegmentation>
<PhotoSegmentation>
<Photold>1</Photold>
<Path>Segmentation2D/1.png</Path>
</PhotoSegmentation>
</PhotoSegmentation>
</Segmentation2D>
</Annotations>
</ContextScene>

3D ¥ A T—ay - FRHUT)
<?xml version="1.0" encoding="utf-8"?>
<ContextScene version="2.0">
<SpatialReferenceSystems>
<SRS id="0"> <!-- Spatial Reference System unique ID -->
<Definition>ENU:49.14428,-122.89029</Definition> <!-- Spatial
Reference System Definition -->
</SRS>
<SRSid="1">
<Definition>EPSG:26910</Definition>
</SRS>
</SpatialReferenceSystems>
<Annotations>
<SRSId>0</SRSId> <!-- Spatial Reference System ID as defined above-->
<Labels> <!-- List of classes composing the annotations -->
<Label id="21"> <!-- unique ID of one class -->
<Name>car</Name> <!-- Class name defined by detector -->
<Label id="6"><Label id="6">
<Name>building</Name>
<IsStuff>true</IsStuff> <!-- Stuff means the class cannot be used
for 3D objects detection -->
</Label>
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</Labels>
<Segmentation3D> <!-- List of the segmented tiles (pointcloud) composing the
scene -->
<Tiles>
<Tile id="0"><!-- Unique tile ID -->
<Path>Segmentation3D/chunk_0.ply</Path> <!--
Segmented tile relative path (pointcloud)-->
<BoundingBox> <!-- Segmented tile (pointcloud)
bounding box -->
<xmin>-1.25160147435901</xmin>
<ymin>-0.907875476026987</ymin>
<zmin>90.6298828125004</zmin>
<xmax>140.341106076638</xmax>
<ymax>117.208998648217</ymax>
<zmax>110.788578636523</zmax>

</BoundingBox>
</Tile>
<Tile id="1">
<Path>Segmentation3D/chunk_1.ply</Path>
<BoundingBox>
<xmin>-1.08100746298399</xmin>
<ymin>117.21081867814</ymin>
<zmin>90.5977325439457</zmin>
<xmax>69.037188812625</xmax>
<ymax>245.285406703886</ymax>
<zmax>118.658285816521</zmax>
</BoundingBox>
</Tile>
</Tiles>
<LODVersion>

<SRSId>1</SRSId> <!-- Spatial Reference System ID of exported
pointcloud in specific format -->

<Path>Insights_SegmentedPointCloud.pod</Path> <!--
Segmented pointcloud relative path -->

</LODVersion>
</Segmentation3D>

</Annotations>
</ContextScene>

T AVMESh =AY TAE - FRGTI)
<?xml version="1.0" encoding="utf-8"?>
<ContextScene version="2.0">
<SpatialReferenceSystems>
<SRS id="0"> <!-- Spatial Reference System unique ID -->
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<Definition>PROJCS[&quot;NZGD2000 / New Zealand Transverse

Mercator

2000&quot;,GEOGCS[&quot;NZGD2000&quot; DATUM[&quot;New Zealand Geodetic Datu
m 2000&quot;,SPHEROID[&quot;GRS

1980&quot;,6378137,298.257222101, AUTHORITY[&quot;EPSG&quot;,&quot;7019&quot;
TOWGS84[0,0,0,0,0,0,0,AUTHORITY[&quot;EPSG&quot; &quot;6167&quot;]],PRIMEM[&
quot;Greenwich&quot;,0,AUTHORITY[&quot;EPSG&quot;,&quot;8901&quot;]],UNIT[&quot
;degree&quot;,0.0174532925199433,AUTHORITY[&quot; EPSG&quot;,&quot;9122&quot;]]
AUTHORITY[&quot;EPSG&quot;,&quot;4167&quot;]],PROJECTION[&quot;Transverse Mer
cator&quot;],PARAMETER[&quot;latitude of origin&quot;,0],PARAMETER[&quot;central
meridian&quot;,173],PARAMETER[&quot;scale factor&quot;,0.9996],PARAMETER[&quot;
false easting&quot;,1600000],PARAMETER[&quot;false northing&quot;, 10000000],UNIT]
&quot;metre&quot;, 1, AUTHORITY[&quot:EPSG&quot; . &quot;9001&quot;]],AUTHORITY[&
quot;EPSG&quot;,&quot;2193&quot;]]</Definition> <!-- Spatial Reference System
Definition -->
</SRS>
</SpatialReferenceSystems>
<PhotoCollection> <!-- collection of photos composing the ContextScene -->
<SRSId>0</SRSId> <!-- Spatial Reference System ID as defined above-->
<Devices>
<Device id="0"> <!-- Photo properties or capture device properties if raw

images -->
<Type>orthotile</Type> <!-- Image e-->

<Dimensions>
<width>3200</width> <!-- Orthophotos width in pixels -

<height>4800</height> <!-- Orthophotos width in pixels

-—>
</Dimensions>
<Band>Visible</Band>
<PixelSize>
<Width>0.075</Width> <!-- Pixel size in meters -->
<Height>-0.075</Height>
</PixelSize>

<NoData>-9999</NoData> <!-- Pixel value considered as no-data

</Device>
</Devices>

<Photos>
<Photo id="0"> <!-- Unique photo ID -->

<ImagePath>Q:/Analyze/Orbit]Jobs/Samples/Datasets/Christchurch/BX24 500 0
25022.tif</ImagePath>

<Deviceld>0</Deviceld> <!-- Refers to photo's properties defined
above under Deviceld 0 -->
<Location>
<UlX>1569040</UIX> <!-- Upper left corner X-

coordinate in defined SRSId -->

<UlY>5181360</UlY> <!-- Upper left corner Y-

coordinate in defined SRSId -->
</Location>
</Photo>
</Photos>

</PhotoCollection>
<Annotations>
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<Labels> <!-- List of classes composing the annotations -->
<Label id="0">
<Name>background</Name>
<Shapelgnore>true</Shapelgnore>
</Label>
<Label id="1"> <!I-- Unique ID of one class -->
<Name>roof</Name> <!-- Class name defined by detector -->
</Label></Label>
</Labels>
<Segmentation2D> <!-- List of segmented orthophotos (masks) applied to original
images after detection -->

<PhotoSegmentation>
<Photold>0</Photold> <!-- Refers to Photo ID defined above and

describing input images -->
<Path>BX24 500 025022 mask .png</Path> <!-- Segmented
orthophoto mask's name -->
</PhotoSegmentation>
</Segmentation2D>

</Annotations>

</ContextScene>
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o {UEIEE(QRI—FDHA): BEIMUEBIRELLTHERINET  LBIEEIZIZRD 4 DDA1THHYET,

o EELQRARANIDHFRIZEEF(0,00)EHRELET,
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ContextCapture MasterKernel SDK [&. Python EXa—ILZ BTV I+ Iz 7EFEFYFTT , ContextCapture
Master DEHEEICT VLR TEET , CNIETODIMDIER. RE. =20 DA—HF—AVF3—Tx(R%
RITTHED21—LITBYFT,

ContextCapture MasterKernel SDK [&. ContextCapture Center TT 423> DHXIGLTWVET , TTaa>DE
M OWTIX TYIE DT DI T 4232 1HFBRLTEZEL,

ContextCapture MasterKernel @ Python €% 21—/l CCMasterKernelPy Tl&., Pyton RVUTMZ&KBL VT ILIEA
BT, hARZTAXENT= ContextCapture 7TV —L a3 &R TEET (WRFITA X PEEEE1To1= 3D 1O
VRS IVIRE),

API £2 21—/l (Application Programming Interface) [&. ContextCapture Master D 7Ok (CCM 74 )L) T
FhOhd. RDEIGTATHEEHZIVMA—I)LTEET,

o TOVIHb- R RECRE. AT aVERE. TOC VN —DERE,
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BARAUDVEREIRE
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EXATIE VAV ARSIV DETIVEIEIZ"EEIRESATOET,
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ContextCapture AAZETIL

AREZDVT

COXENDERIEFEGEESNDGEAENHY . BRI T, RROFFTRHIUEN TLVET , Bentley Systems
#HEFABRICEAL, TRESLIVEEEMNEDOBESHEIZOVWTHRELFIRTZMHLT VA LRIFEIELITOEE
A, Bentley Systems $LI&, AE RO FIRICERT HBERFE-(TERER. MiEsY. M. BRAICELLHEEICD
WT—UIOREREZEVFERA,

HWASETILOAER
IN—ARGTATHASETIL

WERDEBRIRFZIERDHBHIZLOTROLNFT,
x=F.D(I(0.R(X—C)))+ x

CCTIIRDESIZHYET,
XiZ tHREMSBRICE TS —V ADMEERT 3D JINIMLTY,
XIX. BEQOADMEBEEVEILBAEATERT 2D SIRIMNLTYT . RAXELDEBE VL ORDIZAEL, £
MOEBROEARICEMN>T X #AS, RO TARIZAMNOTY #MNRESNTT,
Crhrstos—nfiE%E%RT 3D FINIMLTY,
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Web RRDE=OHDETILEIER

RE:
TAR S T74 v E:
[ COS@COSK COSwSinkK +sinwsing cosk sinw Sin K — €OS w Sin ¢ COS K
R =|—cos@sink coswcosK —sSinwsingsink sinwcosk + coswsing sink
sing —sinw cos @ COSWCOS @

AYTAVT /O— )L/ EvFAE:

[coOSHcosR +sinHsinPsinR —sinHcosR+cosHsinPsinR —cosPsinR]
R sinH cos P cosH cosP sinP
[cosHSINR —sinHsinPcosR —sinHsSinR—cosHsinPcosR cosPcosR |

I3— EFvF /O—ILAE:
cosRcosY —sinRsinPsinY —cosRsinY —cosYsinRsinP cosPsinR
R = |cosYsinR +cosRsinPsinY cosRcosYsinP—sinRsinY —cosRcosP
cosPsinY cosPcosY sin P

CCTRRDESIZHYET,

(Y,P,R) = (0,0, 0)[&, AATA Y AR (X BaAEHE]. Z BaA LA ITKFEICRBERIT TSI LEEKRLET
A—AEL. 2 @EDOELEBHEYDREGEAETT .

EvFAER. X #BErdihEl-REFFEYVDOEEGRAETT,

A—LAEL. Y #EFOELEBEEYDRERETT,

011 3 x 3 DEERTRIVIR T, HASDARIZE>TEESNDNASEE RE N ASEI AT ITET (X 8hILE
BOBRICAR TSR, Y BIZEEO FTRICAAATEN. Z BIZHAATOFSIZHRAMFEINET),

"XRightYDown": 1 0 0
O=|0 1 O
0 0 1
"XLeftYDown": —1 O 07
0=|0 2 0
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"XLeftYUp": [—1 0 O]
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0 0 =1
"XRightYUp": 1 0 0
O=|0 -1 0O
0 0 -1
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Web RRD=-ODETILEIEA

"XDownYRight": 0 1 07
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"XDownYLeft": 0 —1 0
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"XUpYLeft": 0 -1 0
0 = 1—1 0 o0 ‘
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I1:R® = R%iz. e dah 38— AROF (T REEMTT,
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D:R? - R%iz RCEBENDTARP—L 2 BETT,
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II:R® = R%if. O £31- 2B A ABBEL LUT AR —2 a0 TF
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Web RRD=-HDETILEIEA X
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[SRESN, f IFNASOE AR (EVIVERD ITHYET,
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Web RIRD=ODET ILEIES X
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Web RRD=-HDETILEIEA X

3MX ETILHEIED F&E (X Web AR T TIHEWLD T, ETIILFHEL AL THIARIRELGA T3> D d(Z(E, Web
[CIFELGEVEDIHYET . BRICHLTRELGBREZBIRTIVENHYET . FFHlICOVLTIERDEI Ay
=SBLTEEL,

3MX [ZDWTELLHIYLMEE &, doc TALIRJIZEH S 3MX fEHRRF 2 A2 b (3MX Specifications.pdf) & Z &<
&Ly,

ETIVEIMEAT a3y

3MX 74— YhCETILHIEEITIEE . RORV—2F X TFITRT AT avhAFHATEET,
¥ FIslEoESs =
EFIAEDTER

MUOET IEHEDI D A-SEBRUTEE L,

&4 e B Vs
e HNTA-TohEET IAHEDA S0 RIRLE S,

; A e o < D a2 o =sh ford X 2 axcha ot by
F-R AT J4-Tvh: [CortextCaptre SMK ¥ E;m.:lltt:::.:-un_n resh format, cptimized for exchargs with Banthe
THEEE
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i
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O 20k
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3DIHYET, BT, Web BIZTHRKR—FFTBEEIZIF MDY I I 7 EOREERAD BRICITRELZLLD
NOFATLaVEERTIVLELHYET,

IHRR—bATLavaB8IRTDHEEIE. ETIVOXHRAEREEETILENHYET,

1. ROIDATLavIETWeb HIG1T5TTT . COTZTHAVITEOTVRIHE . §TATOREDN Web ETIL
HERICR#E{EESnE T, Ff=. ContextCapture Web Viewer 7 T )7 —L a3V NETFILIZEHONET , Thic
&Y. Web B A TETILEEEMIC(HAVIFEENID ERATE-OICBBLETXTHHRIVET ., TWeb 3t
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Web RRDI=ODETILEIERE
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gl/App/Tscene=Marseille

3. ContextCapture Web Viewer 7 U4 — 3V & f 14+ TavEd 2129 5L, 3MX 74— vb®D 3D —Y
D#IZ ContextCapture Web 7IUAr—SavMEREINE T COT7 TV r—2aviE, o—0TI50HICR
TR BEOIERASNET, IS OLWTIX. TETLOERAZ ORI AV THRALET,

4. TTORFIVTHEEL 1ZFAVILIBE . ET VDT IRAFYNERSINET . 1 DOTIAFYDHAX(E
TRRTIRFA YA RIIEESNIMEFBZI DI EEBYERTA [TOHAFYIVTEEL 154 TIZLEESE.
ETILVDTIORFYIFERSINFER A, Web RRAICIE. TVRAF YDA XM (1EHESH) 2048 EVILERE
ZIEWCEREETT,
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Web RRD=-HDETILEIEA X
ETILOSHER

NMEFBRASZLNTVSTOCIVMDGEE L. ZEMSEROEBRNS Web 7TV 7 —2avITE>TEETY .
SRR, Web 7T/ 7r—23>TOH 3D RIREEZEDERICHELET,

3D RRICEL-ERSBREA—NLEZETERTIVENHYET ENU BIZRF(TIEED UTM/WGS 84
BEEOFEREHELET,

ContextCapture Web 7 ) 7r— 3V (2lE, BAEZDBEEOHIZ, MB DB ESN-EMSE R (SRS) T—2—
ADBAESINTLET , Web Ea—T D SRS T—HAN—X (&, ENU P RT LEIZHED EPSG HEEICHIRINTE
Y, ZeREIMINETEENTEEE AL ZIEIE Web 7T r—2a> TIEZDFFERTIN, BE (EBAKDLS
SRELTRLLIET,

Web 77 r—2avIliBiiEmEER TS HI21E, SMXZE KT 2RI, BUGESEEEREHF OEMSER (B
EGM96) ZERT 2RENHYET

ETILHIERER

BMENEELEALI-ES. 3MX ETI/LIE Web RIEDETILIZHEYET , COBE. ETILEIMERERIL 2 DDER
PR TENET,

FITR 3 IZRT&K3IT, 3MX TA—TVrDI—2h Scene THILAITEDINET , ZDV—2IE, #14T47 S3C
D= ERIBRICO V) —IRDBEEITHEOTWET , —2 D JL—KE. Scene/YourProductionName.3mx 774 )L T
T, K 3 Tl&. ETILDOLAHIA WebGL DT, JL—b 3MX 774 L& Scene/WebGL.3mx TY , 3MX DIERK D5
HIZDOULTIE, 3MX R F AV RESBL TS,

resource

script
&]/ configjson = = = = = = =
I
. WebGL App 1 € index.html :
Productions — B :
[

[ WebGL3mx « - -

BEE D 3MX ETILIZIE. 35 1 D, App EWVSITHILEDHYET , ZDTA /LA 1L, ContextCapture Web 771)
F—arvhBINTWNET , App FHILE BNEHET DL, ETILFHIERIZIWebGL 7TUr—avE /1A
TavEAUIZLEBEETTY,

App ZANFIZHZT7AINDHRT, ROT7AIIZDODVWTEENBETT,

e indexhtml 774 )L, CNIFT TV 7r—2avDIL—I7AILTT,
« configjson F74 )L, CMDITF7A)LIE, Scene/YourProductionName.3mx Z7A/J/LEIELTEHEY . O—FF 52—
> % ContextCapture Web Viewer BT & ENER-LE T,
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Web RRDI=ODETILEIERE
=g

indexhtml Z7AINEZT IO ILTEH. TTIVT—2av ERTENF B A ZBEDTSOY TIZAILHRRE,
ROFEIFRTEIBEEAYVE—UNRTEINET . ChiE. T HFDEXF 1) TAHRENRREATT .

aB--EN
/ ] acute3d x\_

€« C N [ filey///C:/Productions/WebGL/App/index.html R =

We are sorry, but due to browsers’ same origin policy securty restrictions, the application cannot be
viewed by double-clicking on the file

There are two ways of solving this

1. Change security for Jocal files in a browser (access page as file:///example),

2. Run files from a local server (access page as http://localhost/example)

Please follow the instructions here: http://www.acute3d.com/local-webgl/

=~ Benitley

Advancing Infrastructure

106: Web 7 ) r—33> (indexhtml) 32 T IV 0 T Bl TTIHFICEENRTEINET, chik,. IRT
DT SIFIZREINTWBRE—ER TR —NERTY,

WebGL ETIILEA—AILIZRTY BICIE. HHBREDEMMEB AL ETT . SMX ETIVERIET HBEMNDHT
B (L. ContextCapture Desktop Viewer THKAEMNHYET, BAKT7IILDRATELT 3MX ZERL.
Scene/YourProductionName.3mx 77/ JLICBEILET (RORY)—2iavbESHR),
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"3mxVersion":1,
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~— C M [ filey//C/Productions/WebGL/App/index.html B =

We are sorry, but due to browsers’ same origin policy secunty restrictions, the application cannot be
viewed by double-clicking on the file

There are two ways of solving this

1. Change security for Jocal files in a browser (access page as file:///example)

2. Run files from a local server (access page as http://localhost/example)

Please follow the instructions here: http://www.acute3dd.com/local-webgl/
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|| Marseille a

| ‘ , @ port city in southern France, has been a crossroads of immigration and trade since its founding by the
‘ Phoenicians in 600 B.C.E. It's a place of tranquil squares and stepped streets, bustling 19th-century avenues and souklike
markets. At its heart is the Vieux Port, where fishmongers sell their daily catch along the boat-lined quayside. La Canebiére,
the main thoroughfare, runs east from here.

| ‘Vou can visit this beautiful city on-line, using our accurate 3D replica.

[ The 3D reconstruction was done using our

l flexible and scalable software solution to turn simple photographs into true-to-life 3D cities.

solution, probably the most powerful,

{H&% A: ContextCapture Web 77— 3> M O—AHILKR IR
IS DR — L FIA S — b F AU TAHROEDIZ. RORI— v I FrIZRT E5I2. T7AILYRT
LASOO—FEEF 2T BIsHEYEBLET .
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https://en.wikipedia.org/wiki/Same-origin_policy

3MX Web EH

{+8% A: ContextCapture Web 7 7)o — 3> O O—HILKR TR

=~ B --En
y ] acute3d x \7
J

= C fH file:///C:/Productions/WebGL/App/index.html R =

We are sorry, but due to browsers’ same origin policy securnty restnctions, the application cannot be
viewed by double-clicking on the file

There are two ways of solving this

1. Change security for local files in a browser (access page as file:///example)

2. Run files from a local server (access page as http://localhost/example)

Please follow the instructions here: http://www.acute3dd.com/local-webgl/

E Bentley

Advancing Infrastructure

CNERRRT BITIE. RD 2 DDFELHYET

o ISUYT A—HLI7ANIZHTEEXa)T4EEBLET (file:///example TR—I(ZFTI1R)

o A—HIHY—N—DBT7AIILEETLET (http://localhost/example TR—I(ZF7 1 X)

AT av 1 #FRTHEE . BALITTIIYERED Web 7OERIZERT BE. B HEMNELDAEEENHDIL
IEELTESVD. REDEH . O—HILERERDISOFTOI7M IV EEa— vbhEERT526%H
BOLET . COLSEEX1TA LOBENH D=, T3 2 DFEREFRHERLET,

Web RREADY—V2EHNIERTIEEIE. ATVay 2 DEIHEFI)TFAAENEFTEL BEREEH
MEEA, A—HILY—/IN—DHREF 1 BLMTIDELGL, FORIEHLLWETILERTT S=UIZELHE
EMNFATEET,

O—AILIT7AILDEX1) T4 RO —DER

Firefox:

 about:config ZRRLET (CDFT KL A% Firefox DFEHS—L 3\ —IZAHALET),
o [security.fileuri.strict_origin_policy 1/ X5 A—32% B DIFTE 7,

o {E% false [SERELET,
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3MX Web R

f1§% A: ContextCapture Web 77— 3> MA—HIL KRR

Chrome:

o FT.ETHD Chrome [VRIVRETRTHLET  [TRTIEVSANEETT . Windows DIHAE.
Windows DARI I HR— 4T Chrome 1V AAVREF Ty LTLIZEW, H AWML, P RT LML A Chrome
TFAAVHERTESNWTONIE, FOATXRAMNMZ2—2FWVT. & TI1Z29V9ILFET . INT. ITRTH
Chrome 12 RAZVANEFHLGNFET,

o OAYURTAVTR(A—ZFIL)FFAIRLET . Windows DIHFE . M&FRR YU X [IZTCommand Promptj&EA AL
T FERD ARH ST Command Prompt |24 T ILD)vILET,

o Chrome DERATAIBETFZAILDHEITAHINFTERDITET, Windows DIFE. FESF—E2I04UKDT
chrome.exe 77/ ILERELET,

o OYVRTAVTNI—ZF I T, ROAIURSA2TST4ET Chrome DERITARKI7AINERITLET,
path_to_chrome/ chrome --allow-file-access-from-files

Internet Explorer
IBERAIIZIE, Internet Explorer TIXA—AILIT7AILDEX 1) TAR)—4ERTFTHENTESRILT T, =2
L. B TTAREDA, HBixA T a2 (E Windows 8.0 TIEHELAHYEELATLT=,

Safari

o BEHRTE/NRILOIEHISTAZ1—N—T"HR" A 1—FRFIZFEALT AHEAZ1I—ZEHYIZLET .

o JIZ. Safari DIFFE I AZa—mSIO—AILT7AILDHIBEEEMNIZT S 15EIRLET,

o Safari THREET /\WIETIBAIE. ACAZA—DIF vyl aZEMNT B ILBIRLTHTEEHEDOLET,

A—AILY—/\—DEST

A—AIY—N—F A2 A—)LT BEE . Apache. Wamp. nginx 75E . LWOAEIRATREIGA T av by ET,
ZCTlE 1 2O —N\—IZDWTOHRBNLET , CNIZIF BEDN—UVARELWSFALRHYET . BNITHD
[X. http-server T,

AV AL

o https://nodejs.org/MBAFFTBHENTEDAVAL—5D 1 DZEFERAL T, Nodejs FAVAM—ILLET,

o AYURTOVTR(A—ZFIL)ZEFRIRLET , Windows DIHFE . M&FRAR YU X JIZTCommand Promptj&EA AL
T FERDY AN ST Command Prompt 124 TILDvHILET .

o A—IFIJLTROATVREERTLT. npm DRFH/N—2aVNAVAR—ILEN TSI EEFEZELET . sudo
npm install npm -g.Windows MDi54& . sudo F—T—KRIFEETHIENTEET M, v FTOVT N EEE
BLELTETITHIRELNHYET,

o AXURTAVTR(A—ZFIL) TROATURERTFTLET . npm install http-server -g

o Y—N—DT—30CMX T—RZ2EL)EIRTRETLIIHILIEERLETS,

#=F

e 3MX T—%8& Web Ea—7@aE—% —/N\—TH)ILE (A VA= LERRETERLI=T4ILF) RERIZaE—
LFET,

o AYURTAVTR(A—ZFIL)EFIBRLET . Windows DIHFE . M&FRR Y X [IZTCommand Promptj&EA AL
T RN ARMBICommand Prompt &4 T ILY)vILET,

o A—SFIT . H—N—TFILFIZBELET.

o http-server EAALET,
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https://www.apachefriends.org/index.html
http://www.wampserver.com/EN/
http://nginx.org/EN/
https://github.com/INDEXZERO/HTTP-SERVER
https://nodejs.org/

3MX Web & Bfl

f8% A: ContextCapture Web 7 74— 3> DA—HILER TR

o ZMT.HFEDISVHY M5 http://localhost:8080"EANTHIETH—/N—IZFIERTELLIITHYET,
Web Ea—7DIAINAITBBLT, ETILGIEERRLES, TRTOY—VIZEL Web Ea—TF%ERAT S
FHEIZDONTIE TWeb E2—TFDEFEIDEILavESRLTIIZEL,
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3MX %k

kY 72 7J . : — — “
3D EHBBREAYL AR IA— Vv BMX) DTE
COXETIE. 3D BEHEBEAYAKBI+—IYEBMX) IZDWVTERBALET . 3MX DFHRETEZE. HtD
T—ADF AV TORAE IV —RNN—FTA 7TV T— 3 NDBRFERRIZT S BELRA—T 74—
TYbEERTHIETLE, 3MX DEESNIARIIRDESYTT,
o #FHLLYWebGL Ea—7ZFERALIASM1 VB,
o MicroStation 72 & MM Bentley Systems 24 fh D B #atk,
o H—KRI\—F4F7T)5—32(3DGIS) LD E %,
3MX (&, EHBBEDT7TO—FICE>T, EFBICKIFEL 3D Ay aT—20ERLEIMEFEAREICLTVET,
CNIZEY ., =V TRLLND AV AEMRDOMREAHET. 3D LAY T DI=bDT—ERN) =325
M ATBEICARYE T, TREF A T. ContextCapture DRATATE21—TEHLLY WebGL Ea—F7DEAH. O—AHIL
Fl(FH—\—D5 3MX A MBENTEET,
3MX TA—UhE, #EIRIEESEICEVTRASNTIVEY , ContextCapture [FIRFFRTIE, 1 DDAV 2 EHE
247 (0penCTM) EBIBEDTHIAFvBAT (JPG) T 3MX T—RZHERLET, =1L, 3MX HEHTIE AV 1 LMEH
BORBIATIZHBIEHYEL A
LU EZSEICEV-LT.3MX DEHERIIRDESYTT,

e Web LOERMME: T30 ~ADO—FNES

o OV/NJMME

o RANJ—SUJADFREL: EERK RO ATEE

o ¥LERFIAEE

o BHMBEOREIFEICEVNT—IDNIENTTEE,

3MX THEAShIEHERE7IO—FIE. WOOIMDRAIZEDINTVET, ROEHI a3 TIHRINIZDNT
SREALET,
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3D BB EAY AT F+— Y (3MX)

3MX 74— vk

LOD R Al

LANWATT4T4—IL(LOD) 74— vhlE, FFEICKIFEL 3D ETIILDOA—RERELEZRREICLET . ChIL.
ROAFETRRINET,

o Ea—ThoEICBBL-REODERSTHIRLET,
s REDHRAMNRZDETILOMAETEO—RLES,

LOD [V —#BEZIFERALTHEY. R LA/ —FIZIEBICHWEAAZKR T, FIZTKIZ DN TLEWNZHA L 24
FRIZEYES U—T/—KIE. &xb4E#7% 3D RIRTY,

LOD (DR A

LOD VY —DFIERISRLEY B/ —RIZERAIBIRET IRAFYAEENET T mBF LOD RELERQY, FIC
[FREEGAVVAEENEENTEY . BAVVAEREICEESHAFT,

il
J—FA: d = 4002
A T
. J—FB: d = 8041
- / \ _—
: J—FED
J—kC K G
3 AT v d = 100911
~ T / ~
Ty e U D
L N
= a ==
J-FKE J—FF J~FH J-FG

d = 500E2t7)L d = 500E2tL d = 600E7t7)L,  d = 400E702)L

F2EZIE LRI 2 J—FRIE 2 DOFIZHDN, FNENDNETILOFEDE . HBEYHEHLWRT—ILTEAT
WET LRI 3 /—FZERTTBHEICIE. LRI 2 [TERFRICTIVELAHYET,

J—FIEXEEADESIZIGCTRREINET FlICEDE. BIEMNLEWMESIE. /—F A(LR)L 1) BhFRRSH
FIEIIIDONT, /—RIEFFICK-TESBAONTVEFT  zE2 1L /—F A B/—F B IZEFHZS
h,./—FBHA/—FC&DICEEMAONET, /—F CICX—ALLEGEE. /—FCHALRIL 4 /—FDE &
FIZk-oTESHMAONS—A. RHB/—FD D FEDLYFEHA,

/—REFICEO>TESHMADBETIE. /—FATLITHR | B K TESBRAONLGEWNMGENHYET .
HANE, AvL A DEIILICE > T/—FDEAMAKNKIBIHE/NESNHER. BN ZAREREFLLELS
AIREELHYFET . ELEODHERH. B/—FNBETY, C0 LOD RFICIFE/—FNHIBET HAIEEMEAHY.
ERITDVENHYES .

HAOBEDERTIE, ATV — /R ADLRREND/—FIE 1 DFEIF TS, ZOD LOD DFITIE, /—F B A
RERSNTLDIEE . LAL 1 /—RERTENTELT . /—F B DFHRILRTEINTVFEE A,

CCTCTHEIZEADIE . BFED/—FHAEREICRREINAIDIIN+RGAESITHAZLEESHIMT 5N TY .
CMIZBEL T, ContextCapture (Viewer FEfzI& Web Viewer) D7 7A—F TlE, /—FHEIE LIZEK RTINS
RES(EVRIVBM)EZRELLFES SHELZERILT SO, /—FOBERKEZRALET . ERAKEZEER L
ICHRETHLE. ERN d OFIZHYET . COERE d A /—FHABEEIZRTINDIRESORELLTHWLS
nEy,
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3D FHHMBIGEE AV 1T+ —T Y (3MX)

3MX 74— vk
&/ —FRIZIZ . EV I BRREAEEIMEESNTONET, COEIE. /—FHABEEEICRRINDIERESN
B BREIN-BREOER d DRAXIEZRLET ., COEFEBRSE. /—FIZFOFICE-TESHRALN
*9,

758 DA DIRIAEC, B L ADIZEAINL
Vo o andl

&R -F

LoFITEH. ERESEELICEESN-AOEEN 40 EVRILRETHLEIEL. /—FARKRTINETS,
BREROBEDRESININEBZASE, /—F B AA—RENTRREINET,

ETILISGEXKIFE V) —RBENOESRBED/—FRRTEINFTH, ChiZFRZZEH2ICEALTET T,
FThbhb., BFREBETAE)IZO—REINDZDIEFYV)—DTL—EH1E1+TT,

ZOBITIE, AASMN/—K D [CR—LA>FTBE/—FRE EF FRALGGDADT, ETILD D BRIZITEEE
BENDETIMN, /—K CLE.F IFEBIZHYET , AEBHEZR/IMETBIZIE. 5D /—FZHIBRT 2
WELAHYET,

—RHIC. —ERFBRALBIVKREIZHS/—FIFEIBREINET . RG>/ —FIET<CICHIBRESN S H (T
TRBYFRA WASHDLBE T EEFERADESICHDAHREENABSLNLTT , —EREBE>THE/—
RZEHIBRINIEX, /—FDTCICRBESNSERIFBELLBYET . /—FOFNREDLELSNTLNSIEE. £
D/—RIFHIBRENELT A,

FE8HBHE. LOD TD ContextCapture (Viewer Fi=z[E Web Viewer) T—2DRTDRAERDESY T,

e HEAREDERRTIE. L—MBY—TFETD/NNADHT, RREND/—KIE 1 2FEIFTY,

o /—FHRRTENDHDE, BELEADREAHOMNLHERSNI-EE (EVEILELL) [CASHEETY,
o /—FRZELGHR(EMNEEHLORKEFZEBISELLER) ICOAO—FSNET,

o —ERRBRAGUVREICHS/—FIFHIBRESNET,
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3D EHREEAY AT I +—T Y (3MX)

3MX T4A—< vk

3MX TA—< vk

3MX 74—Tvb&E.2 BEOI7AILOLEREINET JSON T+—IVRDIRI—T7()LE N1 F)TH—
TYRDHITIANEBEUVHTIF7AILDYY)—TF , TRA—T7A IS —2 D AT —2%EEH  VhiEEF 3MX

SO THEAEINET . NAFTVIT7AIVIFE AR EEH . 24T 3MXB(3MX /31 F1)) TI, 3MXB 7/ ILIL,
—fREIIZ. 1 DDEIA®D 3D THRFYFEAMAY 1 F TR LET,

312 3MX =V DIANEEEDOBERLET . V—IT7AILIFTIL— b, IHILFIZHYET, Ay aDERAIE
BEOI7ANIZHDN, V) —EETERINTWET , HIT7HIILF L, BN a  TEHBAL- LOD #ERN
DB/ —ROHTV)—5RLET .

Data ey Tile_p000_p000_p000 = | Tile_p000_p000_p000.3mxb
| 3MX.3mx Tile_p000_p000_p001 L Tile_p000_p000_p000_L20_0.3mxb
Tile_p000_p000_p002 Tile_p000_p000_p000_L21_00.3mxb
Tile_p000_p001_p000 || Tile_p000_p000_p000_L22_000.3mxb
Tile_p000_p001_p001 __| Tile_p000_p000_p000_L23_0000.3mxb
J. Tile_p000_p001_p002 Tile_p000_p000_p000_L24_00000.3nmxb
Tile_p000_p002_p000 __ Tile_p000_p000_p000_L24_00001.3mxb
Tile_p000_p002_p001 || Tile_p000_p000_p000_L24_00002.3mxb
Tile_p000_p002_p002 Tile_p000_p000_p000_L25_000000.3mxb
Tile_p001_p000_p000 Tile_p000_p000_p000_L25_000010.3mxb
Tile_p001_p000_p001 || Tile_p000_p000_p000_L25_000020.3mxb

). Tile_p001_p000_p002
Tile_p001_p001_p000
Tile_p001_p001_p001
Tile_p001_p001_p002
Tile_p001_p002_p000
Tile_p001_p002_p001
Tile_p001_p002_p002

| 3AMX3mxb
Tile_p000_p000_p000_1.3mxb

| Tile_p000_p001_p000_1.3mxb
| Tile_p000_p002_p000_1.3mxb
Tile_p001_p000_p000_1.3mxb
| Tile_p001_p001_p000_1.3mxb
| Tile_p001_p002_p000_1.3mxb

109: 3MX D —2 4 ILF R D

3MX 77AJL

3MX [ZlE, —2 B8 % —fRAOIESRAY JSON 74— YR TEENTULVET L JSON T+— v RAINTIVS
DIE. Web 54T UMK BHNIBEBITARZTENSTT,

3MX 74— YD IT7AIVIZIERDABETLHYET .

e 3mxVersion - Z74ILD/IN—30FS GREN/ N A ED)

e name - >—2 % (utf-8 X=F35)

e description - —> D ERAA (utf-8 XF A1),

e HTML Y &S TLIETEFTIN. HITEEL LI TEEE AL

e logo- > —2OMAZENDOITZRTEIR (JPG £1=IL PNG) DAER /X,
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3D HHMRIEE AV AT BT A—T Y (3MX)

3MX 74—k

 sceneOptions - —YDRTA T avDES,

o layers - SEIFHIMTDT % EL 1 DFELIFEHOLAY, O —VRICHEAET IR MBRKRIEIThoDOL
AV CRRBINET,

sceneOptions 27 (&, 7TV 7r—av ORTRAICFHINTWET , 7TV r—2avBEDA T aVEEERT S

F=OIS. AARBLT4—IILREBIMT 5TELTEET,

LAYvaLoiavhD&ELAVIE. ID E3(TEFEODBENBYET . A TITIKRETHT—43%. LAY DERBAIC
BT EHIENTEET,

412, 3MX DEFROBMEERLET,

=BI1—F
=2 IPAINDIA =V

3= UTF-8
——p Y = S 2]
Ll

JSONJA

J7AIDINA

( |
R

\

{ -5 AT P YT \ aLJzay
110: 3MX =27 7AILDITA— Vb

B A TIE, 3MX TEESNBLAYDH AT meshPyramid 71+ T3, meshPyramid LA¥ (&, EHD 3D T
DAFr{tEAmHEAYL 1% 3MXB A TRABLET

&R

UTF-8
pra2 |

JSONJA—-~wH

[ | IPANDIC
Type = 7 = 5 )
n Ay 1t ;

X 111: meshPyramid LA
meshPyramid 24 7 DL AYIZ[&. RDET DI EENET,

id LA ® ID (utf-8 XF5I),
type: meshPyramid LAY DEAL4T,
name LA 4 (utf-8 XF51),
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3D BB EAY AT F+— Y (3MX)

3MX 74—k

description LA OS85 (utf-8 ST=251) .
SRS RIS ER (utf-8 X)) , EAEMHENIT—4

EFHZHETT,, [ERSER(SRS) IZDOWZTIHS
LTS,

SRSOrigin: [00, 01, 02] EEL7T= SRS TOETILDE & (float32 DEZFI),
$EFE LTz SRS TOHRDIELLVERZIL,

P = Pmesh + SRSOrigin T,

V. WAL P

root JL—bk 3MXB 774 )LD/ R (utf-8 XF3F)

SEE 3MX —2I7 M IILDHIERIZRLET,
{

"3mxVersion":1,

"name" : "Marseille",

"description":"Marseille was generated using InterAtlas‘ oblique imagery system.",
"logo":"interatlas_logo.png",

"sceneOptions":[{"navigation_mode":"PAN"}],

"layers":

[

{
"type":"meshPyramid",
"id":"meshe",

"name" : "Marseille",

"description”:"This is a description of the model.It should be between quotation
marks.",

"SRS":"EPSG:32631",

"SRSOrigin":[692625,4798280,0],

"root":"Data/Marseille.3mxb"

}
]
}

=L AVIZEENDIL—IEFERHTBIET, JL—k 3MXB T7MILDSIEH T, LA IREO—FFTBIENT
=F9,

3MXB 771 Il
3MXB ¥R 7+ —<vbE. RIDEH 3 TiRBALT= LOD ORAIZHEWLET , SO T+— IV —1E&E
ThY. B/ —FOERBERENFICHO>TLET,

3MXB 77 IIENAF I IH—T IR TCHERENTET , /—FFEZ/ —FDEYMIREBELRTRTOT—E2(FTART
DT IRAFrELEMBREED)ZETH., THIESHELTWET, 1 DO 3MXB 7/ /LIE,.LOD V) —DEHD
J—FRERBIBHIENTEET . COBA. ITRTOD/—FARE, THEHLLRERICIEREE/—FDFTT,

3MXB 74—<YhMIXDEEFTRYET,
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3D HHMRIEE AV AT BT A—T Y (3MX)

3MX 74 —< vk

®I1-F

g | Avy- UTF-8
B \ WA — W, 2 W ? |
e ) R e /77 71

|asonsa-—wt SAIIT 4

[
[ | \

112: 3BMXB 77 A I+ —< vk

3MXB 77A4ILDFEEEIZIX, [BMXBOIEWLWSIRIOVIBENEIMET , ZTDRIEL SH TT, CNIET7AILDAY
H—DINAERLET , SH (F/314F) 74—y D EIE (uint 32) TI,

SH OF<CRIZ, T7ANAYE —EE T, AvT—IE, A4 XH SH D JSON T+—<YbXEHTHY . ROK
BMDHYET,

version: 1

nodes: [node_datao, -**., node_data m] RBET—2DES, ZRBIZ1 D
T2, /—FORBIT. ERDEY
LIV THRESNET,

resources: [resource_datao, **+., resource JY—ZAAT—HEDEH, /—F

_data p] ISHEBELE))—R(THIORFYE

Tl A AR) (LT 1 D9
Do YY—RT—EDFHMIIID
#THRBELET,

3MXB 7 ILDFEIZIE. WO DNAF Y\ IT7hREIMNET,

INVT7 o NAF)T—=BINT7, NV ITF7DEATEZF DD TR
INTAIE AYE—D))—RATIEESNET,

INYDF INAFT—RI1\T7,
-

ANYE—ZBFEND/—FT—RIZIE. T7AIZEENS 1 DD/ —RDT R TDAIT—ENREFSNTVET,
J—ti

| 3soNA -zt

f

[" L, =5 Wy y. i
n sppalacdll i oS, T: IPOLER Y- ZID

ContextCapture 245 aA—H4—HAF



3D EHREEAY AT I +—T Y (3MX)
3MX 74— vk

id: REDID, CNFTF7AILAT—ETI A,
V) —E &SR TIE—ETEHYEEA,

bbMin: [mino, min 1, minz] BRAVIZADRNER, BRRVIRIE,
ST TEBEFD. /— DMK
DRIMEFRRVIXTT,

bbMax: [maxo, max 1, maxz] BERRYIRDRRIER BRAVIRIE.
EEAZ B 1T E D /—F DA ARZIK
DRNEFRHRVIZXTY,

maxScreenDiameter: dmax CD/—FERTTOIRRKEFR(EIRILE
1), BIE EDHYAZXNZDEEZBZSE.
/—REZEDF (FETSHER)IZL>TESE
BAONFET,

children: [file_namey, **-.file_namey)] J—RDFEELT7AILFB/SR)D
)X,

resources: [geometry_IDo, --.,geometry_ID:] | /—RZ#EHRT HEMARKRD AR, ID
ANYFE—DY—RALIL AV RN —R
ZHELET,

J—RD))—RABRIEEDHEELHYET . ChITE/—FEEELET, 3MX TA—YMIIXE/—RKAHIET
HAREMAHY . BEETDIDLENHYFET  T/—FE FREAIBKEMOR MK TEETRZ LD TEL, FERT
CTEILENHDIILEZRLFT . CNICHLT. FAREELGVWESEEF . BEELOBRES AN
maxScreenDiameter /N\TA—RZEBA-IHETH, /—FERBICRRLTHLILEETRLET,

)Y—RT—4
ANYE—D))—RaAL v avid, 3MXB J7MIIZEFENE/— RV KD ERETRT H=OICHLELRT A
TO)—REFZRLET, BUY—ADT—RERDELSIEBREINTLET,

| 3sONTA -9t

JY—ZX ID &, /—FEVY—REFERF T ERENEZR-LET =X ID ZEALT, BAFBRKEELLN/ —F
([CEEER 1Y BIATRRERIET DT IRAFvITUILIZYT HIENTEET,
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3MX 74—k
JY—RIZIZRD 4 DDEATHRHYET,

o textureBuffer, CNIETIRAF¥H 3MXB F7MILIZEENTLSEDTT,

o geometryBuffer, CALl& 3MXB Z7AIILAD /A F )\ T 7 TAYL 2% iR THEDTT,
o textureFile, CNIETIRAFYBNEIT7AILICEFENTLSDEDTY,

o geometryFile, AT AV AN EBI7AILIZEFENTLNDEDTY .

INVITFRATDBE . N FTVT—BIEAVE—DED /N IT7—FTOIIMD 1 DIZEFTATNET, 1\ IT7D
BExEREIE. YY—RaLsiaven\yo7alb s arc—HMLET,

1. textureBuffer
TORF/NYITF7D JSON T—REIRD XS ITHEHEINTNET,
{

"type":"textureBuffer",
"id":"tex0",
"format":"jpg",
"size":1513,
}
"d"E FFAIVAT—EITTIRFYEHALET L. 2O ID (V) —BELART—ETEHYFELE A,

"format"2 71X, TORFYEERDEATERLES . TVRF Y\ I7ADERIZ. 3MXB T7/ILAD /N1 F
DN TFIZRBFESNTVES N FUT—EDH A XIZ, "size" DIETRENET
2. geometryBuffer

ARV TF DA T—RIERDESY T,
{

"type":"geometryBuffer",
"id":"geometryl",

"format":"ctm",

"size":835,

"bbMin":[-1243.69,-314.572,52.6138],

"bbMax":[1243.69,314.572,52.6138],

"texture":"tex0"

}
"id" (&, T7AILAT—EIZE AR E#HALET, F-ZL. 2O ID (V) —EELAFRT—ETEHYEE A,

"texture" 27 AT THY . BRI NTIRAF Y CHIAEANDHEFELET . COBE. TIVAFvIL ID
THAINFET, LOBITIE, EATRIZITIORFYINYIT7 IO IV TEREEIN="tex0" T IR Fv&{H
ALTWET,

"bbMin"&"bbMax" DIEIL, EAHIKRDBERRVIRE, /—FT—42DGEELRLAZTRERLET,

3. textureFile

TORFXIT7AILD JSON FRRIETIRF Y\ IT7ERBTOWET A, NV IT7OH A XDKDHYIC, BgEE
STHEITFAINDISADNIEESNET,

{

"type":"textureFile",
"format":"jpg",

"id":"tex1",

"file":"subfolder/SomeTexture.jpg",
¥
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4. geometryFile

TFHORFNI7AILVERR, ., ERAFIRT7AILD JSON [ZIX, "file"BT HREENE T, CHIZHNEDERFKR T 7
AILEELET,

{
"type":"geometryFile",
"format":"obj",
"id":"geometryl”,
"file":"subfolder/SomeMesh.obj", "texture":"tex1l"

}

ID [C&5SHE
3MXB Z7AILIZITEHD) )V —ANEFENTEY., TOITRTEREICBATEILENHYET, T TIZEHRBAL
f=&3I2, /—FRE)Y—REHE VG T 5012, )Y—X ID BMERSINET,

1 2HDOREIE, /—REEARARDBORIETT , /—RDT—RIZEFENZY—REHIZIE, /—FIZET ST
RTOEMMABKRIY—ZAD ID BNHBESINTOET . AVE—D)Y—REFIZE, T7/ILADDELEL 1 DD
/=R TRERIRTDIVY—ADNERENTVET, /—FDYY—X ID EAvFT—NDYY—X ID #BET B
T./—FORABKREBBET HIENTEET,

TOET, /—F 0 [ZIE VY—R 0 £VY—R 1 DERMBKRELTHIELET  UV—R 0 DAASTHERRIK T 7
AINTHDDIZHL, UV—R 1 DEATIEEMBRK /N T7THY ., Aviald/\vT7 0 ITRFINTWET, /—
F1IX)Y—R2 OHEABIKTERZRINET . CNIEN\YT7 1 ITEENTULET . AVFT—RHD)Y—XDEF X
NYI7DIEFE—HTHD T, /AyI77 1 (FEEMIC)Y—R 2 IZHISFITONET,

) | ned = _ : : .. UV—ZpO@IHR(E) (I rnl TFHL
2 o5

/- FOTBAANSEOAZRIY — X

1]

J—F1TEHEIN 2440 2RV —R
ROL2 19
113: 3MXB TD))—RAD R ATIT, &FIN\AF)T—42, FIIXFEIT—4ERLET,

BATRRKIE 1 DO/—FIZEBLET M., /—RIZHET R MABRAV 2 FELEVEESE. 1 BEOGEEL. &
BOBELHVET . /—FHIEROE M REZEDEHIE 2 2HYFET.FE 1 12,1 DO/—FBTHIRFrftE
ETVRAFHELDT—REFHDGEC. BROERICKETIRAF I HAEDT 2% EFIGEENHYET . D LS
HIBE, BABREEHRD/NN\VI7IZHEIL. 1 DD/INYIFT 1 DDTIRFYEEET DDHIMERTT, F 2
2. VAT LIZESTIE, EAFIR/ Ny T7DH A XH MAX_USHORT DIEIZHIRINBIEENHYET, =& IE.
WebGL Ea—7RIFICERSINZI5E . #AH24K (X MAX_USHORT (65,535) L FDH A XD\ IT7IZHBlShFE
T, INIEA—FIrDEL—TFITIHCTHET ZIENTEET,
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2 DHDOFIGIE, AR RAYY 2EFNIZH BT BT IRAFYDOEDORIETT , CDHES. JY—R ID NEBEIC
FRINET, BABRKAV2E 1 DDTIRFYEF ON. TIRFYEF LGOI DELLNTT , TVRAFY
NBEIHE X, "texture" 25 DNEMBRDERIZEELE T IBESNZTIRAFY ID (L. AVF—DYY—R
aLYLAVIZEBBEINTWSTIRAFYIY—ZADID O 1 DI—HTI2BELHYET,

TOARFYIE, B14b/—F T EHOEMBRKINSHERTLIENTEET, LEROBITIE, JY—R 0 EJY—R 2
DEA, VY= p DEBEDTIRFYHEFERALTLNET,

JSON R DTELLEAVE—DFIZERIZRLET

{
"version":1,
"nodes": [
{
"id":"node@",
"bbMin":[28.7803, -12.6859, 17.3977],
"bbMax":[30.7065, -2.68368, 28.2069],
HEDEE

"maxScreenDiameter":118.819,
“children":[ "Tile_p000_poo0_poo1_L20_00.3mxb"],
"resources":[ "geometryo"]

}
1,
"resources":[
{
"type":"textureBuffer",
"format":"jpg",
"id":"textureo",
"size":1665
¥
{
"type":"geometryBuffer",
"format":"ctm",
"id":"geometryo",
"texture":"textureo",
"bbMin":[28.7803, -12.6859, 17.3977],
"bbMax":[30.7065, -2.68368, 28.2069],
"size":1233
}
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RAEDEE

IR7E. ContextCapture A% 3MX 74— YbEIIRR—ET BIEIZIE, LWODD/IRSA—FHEESINET ., =
NICKY BED/A—23> 0 3MX T+—T VD ERSINET,

ContextCapture [ZKD IV RR—FDEHHKHMED 1 DIE. 1 DD/—FDFTRTHFA 1 DD 3MXB Z7AILIZ
SLERSNBIETT . i, A—FEEEIEL. FRAEVZENT B=HICThhExEd . TLOD OREI &Y
2aVDBIIZRDE. TYRR—rEINTz 3MX O—2UIERDKSITHYFET,

' \——"‘
bR x J—FA: d = 40F 5121 P41
\‘ % "
bz, x J-¥B: d = 80O T2
il
J—ED 4
/-FC - 100r P03
2 e § 100E08)L
: Y -
2 / - -
J-FE J—FF J—FH J-KG P44 0 TP AL4A_1
d=50005t) d=500C0t0 | d=600E4t) d=400L7t0

CCT.HARDOESIE 1 D0 3MXB J7(ILERLET,

3MX DIHRKR—

BE. TVRR—,ENE3MX O—2IE. 1 DDEED 3D TIORFEHHAYD 2ITHIBINET, T4
5. ERENBLAYVIE 1 DT, TDE AT (X meshPyramid TY , ZDDT—42(0B] Ay245 3D Avyia
[ZRFONFIRNIVGE) [T BEDEETEBRSNFEFEA,

D1 20LAYDMIZ, TVRR—bENiz 3MX 74 L TIE. sceneOptions ALY 3T 1 DDI—F
ToavhBFEELET, DA T3k navigationMode THY . FDEILX"ORBIT"&1=(L"PAN"TT , DA
ToaviF, a—F - —UERETIHEDMHRELLTHLLAET,
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3D HHRIGEAYL AW T+—T v (3MX)
3MX A —< vk
3MXB D ITHRHR—k
IHRAR—FENT- 3MXB 774JLTIEL. LOD YU—RADRBRILTH. 1 DDNAF)IT7AILIZERERSNFE T,

Li=ASo T ERiEN Tz 3MXB (2K TORF v\ I7ERFTRKNVT7DELT D) —REIT A EERE
o TORFYIT7AIELITEAMART7ZAILDEAT D) )—R (&, ContextCapture M ITERINEE A,

1. textureBuffer

1R85 M TlE. ContextCapture IZKD IV RAR—FTHR—FEINDZDIE jpg 7A— VT TY , jpg 177
ANV ITFRIZEFDEFREFRSNET,

2. 2geometryBuffer

Bz AR/ N7 7IE. TREF R TIX OpenCTM 774 )L (http://openctm.sourceforge.net/) D& TéHY ., 3MXB
T7AIVADNAF )N IT7ITRFEFSNET,

OpenCTM 74— YMIIERORABNEENET
L& [vo, ***, va] TERGLEDEF, vi = [po, p1, pz]

&R [no, =, N TEREIRDERS,
A7 av BEATEEEFNEEA,

T RF ¥ EEZE: [uvo, =+, uvn] ERTIVRAFYEZDES, uvi = [y, v]
AR ICTIORF e HEEMTONTVBIEEDAEINTY .

=ARATYIR: o, if] BEAVTYIRADES., ix=TEREINRNDEIGE,
ATFVIRIE 3 DT OC=AREERLET,

TRSERIZDNT
EHSBRIE. 1 DDEEXFEINTERINET , S IE—HBEYIZ. EPSG B & FE =% Well Known Text (WKT)
XFITY RGN RILEELZFRHT 5 EETEET,

EPSG a—F

ZAREMHE L RTLICHIET BIFLAED EPSG EBNYR—rShET,

2R YYA(E"EPSG:CODE"THY | i X T LikZ D EPSG A—FEEZELFET (. "EPSG:32651") 6
EA—MLLRT LIFERSNERA BERIRTLLE),

Well Known Text (WKT)

OpenGIS WKT 74— vrDEZRIE, TDFEFIRETHENTEET,

ZTOtDEE

B—7)L East-North-Up (ENU) Y R T LEZEERT DIZIE. RO AVIREFERTEES , "ENU:LAT,LON" (5,
"ENU:41.57231,2.26157") ,
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REF DAL

PTX £4%
ContextCapture [&. Leica Cyclone @ PTX 74 —<YMIFIGLTLVET,

FTARTODPTX RENAEDFEREF OERLGEINSO. RBEILTAERBUERHOEITRYET , RO
27 DDERLVHDEE. BOFRSRESNTT

il
ANYE—DREERVANDREZ. EAGLDTHIBELHYET . AT —ADRPO. 2 DDAV —RED
RARFELTNDE AVR—PIS—ITHYFET, L, AR ORI BEHENFET,

ROERF, BRITIE AF VY FHBELTRI Y FOBFMEZEAL, SHESNETS,

AXvF BRI —F—AEA—TIAADNSIEESN-HETEH. PTX AVHA —HNOEHRITHEFRALTAD
A HEINT T LED BERB#EEL PTX (CIXFIATEE A,

LAS £1&
ContextCapture (&, LAS 74#—<vk 1.0, 1.1, XV 1.2 ITHRHELTLET,

FREEND LAS BT—3DLa—KI74+—<yrZHEINWT, BDBEHNMBREINET FRINIEDT+—
IUbH 2 F2(E 3 DIGE. RRIBEERHERLFET . AEEL 1 DDEDREN 0 THIMGE . LERH
NRESIhET,

B
LAS 74— ykld RXvF B DIFRICITRELTUOVER A, 588 LAS A UR—h T 5EE1E. XX v T D
MBEI—H—AVF—TIARANLIRETHH . BBFREEEELFERITIDELHYET,

E/NML
REEIMT 2L, B4 LREVTIZETIVIENTVET , TD1=8H . LAS RT—EDLI—FIT+—<7y
MME1H3 THILENHYFT

E57 £#%
ContextCapture [, E57 74#—<vhk 1.0 & Leica E57 XL TLNVET,

E57 74N AYE—[ZEDNT, BOERISIBEINET AV —T. FR. KB HBD AT —ILER
true [IZERESNSE, ARIIBEEERHbET . T . AEDET—ILLEZFERALTAERENRESNET,

B

AFvFDEEX. E57 AF v DR—XFRIASHAWMYET , COFEBRNIREZELTLSEE. R—XIE ID
[CRESNTWBERLGEINET, ID R—XIKXEEM TS -mBEICXEATELG O, BERFITEh -5
IR v IZlER— X ERADETT,

AF v UENI—F—AE—TI(ANLEESNBEE L, BBRESNEETH, E57 XX voD
R—REREFEALTROEENHESNES,

ENMN

RBLBIMT —2E. A LRIV TITES>TYUIENTVET . TD1=8 ., D7KEEL 1 DD E57 AFvr (T4
ALREBTI4—ILENKLE T, E57 AFX v A acquisitionStart #EDIZE . TNEND A D T=HIZHEHHK
SINFAA LRIV T DA Ty ELTEAMERSNE T, E57 I timeBounds #iEH KU timeMinimum 1
ENHDHIHE . timeMinimum DIEIXZNZTND RD=OITHEASNI=FA LRI TDF 72y ELTHER
S, acquisitionStart #EEXYBBESINET,
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BT —4

ENANRF v EAR—FTBIZITBVMERABETY . M7 AILIZIE, A LRZV TIZEERSF TS
NERAXYFUBDVANEEDDILENHYET . COMNEIX. RBHOEETIIHKRILERS B R TIRES
NEZBELRHY MDD ZA LRIV TIEEDEA LRI TEF—N—S9TTEILELHYET,

BRI -

Time;X;Y;Z

189321.10;15.96;-52.12;133.68
189321.20;15.21;-51.21;134.01
189321.30;14.75;-50.37;134.35
189321.40;14.10;-49.50;134.31
189321.10;13.78;-48.69;134.43 ...

PLY &%
ContextCapture [&, —f&H97%: PLY 74 —<vbE &Y NavVis PLY 74— yMIRIELTLVET,

ContextCapture TIX, PLY 74— YMIENAINITA—IYREHLEEINET . LT —2IBHEHYE A,
TNTNDORITEREBRPBETT,

ERDOTO/RTAAIE nx, ny, nz T, BOTANTAAIEF. & T THIDLELHYET,

POD £
ContextCapture [&, POD 74—k (Bentley D R T74A—<yM) IZHIGLTVWET  BEE. —BEDV—X%
FEALBURF YU DI-OICOHAR— T HIENTEET,

B
AVR—FEEEIZTIEOIZAEED POD J7MILDRX YU NEBEIEET 50 . R MEEEFERAT S
BERBYET,
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